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The copyright and ownership of this manual belongs to Autel Robotics Co., Ltd. No person 
may copy, scan, store, disseminate, transfer, sell, transfer, or change without the written 
authorization of Autel Robotics. This manual and its contents are only for the operation and use 
of this product, and shall not be used for other purposes. 

 

Recommendations 

Autel Robotics provide users with the following materials for best use practices of Autel 
Mapper: 

1. "Autel Mapper Installation Guide" 

2. "Autel Mapper Quick Start Guide" 

3. "Autel Mapper User Manual" 

4. It is recommended that users first use the "Autel Mapper Installation Guide" to 
understand how to install the software and check hardware compatibility; browse the "Autel 
Mapper Quick Start Guide" to facilitate users to quickly understand how to use the software 
and perform 2D and 3D reconstruction tasks, and finally utilize the "Autel Mapper User Manual" 
for a detailed explanation of both beginner and advanced techniques for using the software, and 
explanations of technical terms within the software. 

 

Documentation 

※The following guide is subject to update without prior notice. It is recommended to visit 
the official website of Autel Robotics to confirm you are using the latest version of this 
documentation. 

                      

                                    Or 

 

                                           Click Icon To Download 

 

This manual is written based on Autel Mapper V1.1.0. If it is inconsistent with the version of 
the software you are actually running, please update the software to the latest version. If some 
operations are inconsistent with the manual description due to a newer software version, please 
refer to the actual software. This manual is for reference only. 

 

  

https://www.autelrobotics.com/download/594.html
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 Product Overview 
 

This chapter introduces the basic functions of Autel Mapper, the performance requirements 
of software and hardware, and how to obtain an Autel Mapper account. 
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1. Product Introduction  

Autel Mapper is a PC application independently developed by Autel Robotics Co., Ltd. 
(hereinafter referred to as Autel, or Autel Robotics) for various industries and applications. It 
utilizes the latest in reconstruction technology for cutting-edge 2D and 3D map and model 
reconstruction capabilities. 

 

1.1 Download Autel Mapper 

Using your computer, please visit the following link to download the latest version of the 
software: 

https://www.autelrobotics.com/download/594.html. 

 

2. Usage Requirements 

For the best possible experience and to avoid poor performance, Autel Mapper needs to 
meet certain software and hardware requirements.  

Note: 

 Autel does not provide any computer hardware alongside Autel Mapper, the software is 
provided alone, and it is up to the user to ensure their hardware meets the requirements 
as stated in this section. 

 

2.1 Operating System 

 Windows 10 64-bit or Windows 11 64-bit. 

 

2.2 Hardware Requirements 

Specification 2D/3D Reconstruction 

Hardware Lowest Supported Model Recommended Model 

CPU 
Intel Core i5 8 series 

AMD Ryzen 5 3000 series 
Intel Core i7 11 series or newer 

AMD Ryzen 7 5000 or newer 

GPU NVIDIA GeForce GTX1070 
NVIDIA GeForce RTX 2080 Ti  or 

higher 

VRAM 6GB  8GB or higher 

RAM 16GB 32GB or higher 

Storage 200GB of usable hard drive space 256GB SSD+2TB Enterprise HDD 

Display 1280×1024 1920×1080 or higher 

https://www.autelrobotics.com/download/594.html
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Notes: 

 Please keep your computer operating system up-to-date, including drivers, to get the 
most out of your hardware. 

 It is recommended to use a higher-end desktop processor for the best possible 
performance. 

 The graphics processor must use an NVIDIA graphics card with a computing power of 3.0 
or higher, and the graphics card driver version is required to be 471.11 or later. 

 Please configure memory and storage reasonably according to the actual data set to be 
processed. Among them, memory should be about 500 sheets/GB, and storage should 
be 5 times the size of the data set. 

 Lower requirements than the minimum configuration may result in poor experience of 
the software, crashes, or a failure to boot the program. 

 The official recommended configuration of Autel Robotics is for reference only, and large-
scale data sets may need to upgrade to a higher configuration. 

 

2.2.1 Installation Precautions 

During the software installation process, if you encounter any security popups or blocks, 
please choose to agree or allow the program or setup to run. For details, please refer to the 
"Autel Mapper Installation Guide". 

 

2.2.2 Graphics Card Update Guide 

Please refer to the "Autel Mapper Installation Guide". 

 

3. Autel Mapper Account 

Autel Mapper accounts are divided into two versions - CN and General Version. 

 

3.1 Select Account Type 

The login page will pop up automatically when you run Autel Mapper for the first time. Users 
can choose the domestic version or the international version to register and log in according to 
their needs. The registration methods of the two types of accounts are different, and all 
functions of the Autel Mapper software can be used after logging in. 

Tips:                                                                                                                            

 The two versions are not interoperable, please choose carefully. 

 In a non-login state, users can only use some functions of Autel Mapper, and cannot use 
the complete functions of the software. 

https://www.autelrobotics.com/download/594.html
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3.2 User Registration 

Click [Create] in the lower left corner of the login page, and enter the relevant registration 
information on the corresponding account registration page to complete the registration. 

Tips: 

 Upon registering for the first time, you will get a 3-month trial period to use the software 
for free, allowing all functions of Autel Mapper. After the trial period ends, users need to 
purchase an Autel Mapper account membership to continue to use the software. 

 

 

3.3 User Login 

CN account users can freely choose two login methods: password login or SMS login. 

General Version users must log in through email verification. 

Note: 

 Password login is in the form of registered mobile phone number + password; SMS login 
is in the form of registered mobile phone number + SMS verification code. 
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 Email verification is in the form of registered email address + password. 

 
 

3.4 Forgot Password 

If a user forgets the password of their Autel Mapper account, simply click [Forgot Password] 
in the lower right corner of the login page to reset the password. 

CN version users can enter their mobile phone verification code to reset the password, and 
General Version users can reset the password through email. 

 
 

3.5 Purchasing A License 

After the user logs in to the Autel Mapper account, click the [Trial] button in the upper right 

corner on any interface of the software, and fill in the relevant information to complete a purchase 

application. After submitting the application, Autel Robotics will follow up and grant a license to 
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use the software.  

Tips: 

 When the mouse hovers over the [Trial] button, it will switch to a [Buy Now] button. 

 Purchase application reviews take time. In order to avoid affecting normal use, if you are 
willing to purchase, please submit a license application more than 3 working days in 
advance before the end of the trial period. 

 
 

4. Glossary 

Acronym Full Phrase Meaning 

GCP Ground Control Point 
Describes the specific geographic information of 
a point on the ground with a specific identifier. 

POS 
Position and Orientation 

System 
A specific geographic location. 

DSM Digital Surface Model Detail and data of ground models 

DOM Digital Orthophoto Map A model derived from data (orthophotos) 

LOD Levels of Detail 
Hierarchical, used for processing and rendering 
based on position / distance from nodes 
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 Project Management 
 

This chapter introduces Autel Mapper's functions related to project management, including 
creating new projects, exporting and importing projects, switching project display formats, 
renaming, deleting, sorting, searching, and switching topics. 
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1. New Project 

1.1 Creating A New Project 

Users can use either of the following two ways to create a new project. 

 Create a new project with image files: Create a new project by importing images, and 
there is no need to import images separately after completion. 

 Create a new project without Image files: Create a new project directly, and you need to 
import images separately in the project after completion. 

Note: 

 Autel Mapper only supports images in a .jpg format. 

 

1.1.1 Creating A New Project With Image Files 

After opening Autel Mapper: 

 Drag and drop the image files onto the computer's local disk or directly to the homepage 
to begin a new project. 

 Drag and drop the image folder in the local disk of the computer directly to the homepage 
to begin a new project. 

 Click the [Select Images] button on the home page to select an image from the 
computer's local disk to begin the new project. 

 Click the [Select Image Folder] button on the home page to select the image folder from 
the local disk of the computer (all image files in the folder will be imported into the project) 
to begin the new project. 

Note: 

 When you choose to create a new image folder, the image files in the subfolders within 
the folder will also be imported into the project. 
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1.1.2 Creating A New Project Without Image Files 

After opening Autel Mapper: 

 Click the [New] button on the homepage. 

 Use the shortcut key [Ctrl+N] to begin a new project. 

 Click the [+] icon on the top tab to start a new project. 

 Click [File-> New Project] on the menu bar in any open project page to start a new project. 
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1.2 New Product Page 

When creating a new project, the new project page will pop up automatically. Enter the 
project name and project path in this page to complete the creation of the project folder, 
allowing for easier management of the project later. 

 
Notes: 

 If you create a new project with image files, it will display how many images have been 
added on the new project page. 

 Project name: the name of the project folder can be customized by the user. By default, 
the current year, month, day, hour, minute, and second are displayed (the length is 
limited to 64 characters). 

 Project path: The path where the current project folder is saved. The original data and 
reconstruction results of the project are all saved in the project folder. 

 Default path: After checking the default path, the project folders of subsequent new 
projects will be saved in the same path as the current project folder, otherwise, the user 
needs to manually select the project path every time a new project is created. 

 Click [Cancel] to cancel the new project and return to the home page, and click [Create] 
to enter the project page. 

 After the new project is successfully created, you can view the created project in the 
project list on the home page. 
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2. Export Project 

In the project list on the home page, click the […] icon in the project and select [Export 
Project] in the pop-up menu or click the menu bar [File->Export Project] on the project page. 

 
After selecting the export path, the export progress bar pop-up window will pop up 

automatically, click [Cancel] to cancel the export. 
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After the export is successful, you can view the project folder under the selected export path, 

which contains project pictures and reconstruction results. 

 
 

3. Importing A Project 

Click the [Open] button on the home page to open the system file explorer, select the project 
folder to complete the import project operation. 

To successfully import a project, the following must be met: 

 The selected folder must be an eligible project folder. 

 The name of the project folder must not be the same as a project already in the 
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homepage project list. 

 
After the import is successful, it will automatically enter the corresponding project page and 

display the existing processing results. 

 
 

4. Toggle Project View Options 

The item list display forms are divided into [Grid View] and [List View], the default being 
[Grid View]. 

Click the [List View] icon or the [Grid View] icon next to the search bar on the right side of 
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the homepage to switch the item list to the corresponding display format. 

Notes: 

 Operations such as [Upload Log], [Export Project], [Rename], and [Delete] in the two 
forms are the same. 

 The file size of each item is displayed in list form. 

 
 

5. Renaming 

In the project list on the home page, click the […] icon in the project and select [Rename] in 
the pop-up menu. In the pop-up window, enter the new project name (it must not be the same 
name as the project in the project list) and click [Confirm], the file will be renamed. 

Note: 

 The renamed project name must not be the same as an existing project in the project list. 
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6. Deleting 

In the project list on the homepage, click the […] icon in the project and select [Delete] in 
the pop-up menu to delete the corresponding project. 

Tips: 

 The [Delete] operation will delete the corresponding project folder at the same time, 
before deleting, always confirm you are aware of what you are deleting. 
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7. Sorting 

7.1 Sorting With Grid View 

When the item list is displayed in the grid view form, it supports three methods: [Last 
Opened], [Create Time], and [Orders in Queue]. 

 
 

7.2 Sorting In List View 

When the project list is displayed in the form of a list, it supports four methods for sorting: 
[Processing Progress], [Last Opened], [Create Time], and [File Size]. 
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8. Searching 

Enter the project name in the search bar on the right side of the home page to query the 
project, supporting exact match or relative match. 

 
Tips: 

 After performing the search operation, only the corresponding search results are 
displayed in the project list area. At this time, you can press the [ESC] key on the keyboard 
or click the [X] button in the search bar to return to the project list overview, and the 
search box will be automatically cleared. 

 When the search keyword cannot find a relative match, "Data not found" will be shown. 

 

9. Switching Themes 

Autel Mapper currently supports a dark theme and light theme, with the default is dark 
theme. 

Click the [Theme] icon in the upper right corner of the homepage to switch back and forth 
between the two themes. 
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10. Switching Language 

Autel Mapper supports two interface display languages: Simplified Chinese and English. 

Click the [Language] icon in the upper right corner of the home page to switch between the 
two display languages. 
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 Applying And Using Data 
 

This chapter introduces the relevant data operations of Autel Mapper, including image 
management, POS data management, camera management, and setting the output coordinate 
system. 
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1. Adding Images 

When creating a new project without image files, you need to add an image separately on 
the project page. 

Tips: 

This operation can be ignored by creating a new project without image files. 

 

1.1 How To Add Images 

After creating a new project without image files, on the project page: 

 Click [File->Import Image] or [File->Import Image Folder] in the menu bar to import 
image files from the local disk of the computer. 

 Click the [Select Images] button or the [Select Image Folder] button on the right [Manage 
Image] page to import image files from the local disk of the computer. 

 Drag and drop images or image folders from your computer's local disk directly into the 
project page. 

Note: 

 When an image folder is selected, image files in subfolders within the folder will also be 
imported into the project. 

 
 

1.2 Image Management 

After successfully adding images, the added images will be displayed on the [Manage 
Images] page on the right. 
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Click the [-] icon or the [+] icon in the upper left corner of the [Manage Images] page to 

modify the number of columns displayed in the image management page. The default is 2 
columns, this can be adjusted from 1 to 5 columns. 

 
Use【Ctrl+Scroll】to zoom in/out of the currently selected image. 
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Click the [Reset Size] icon to restore the zoomed image to the default display size. 

 
In the [Manage Images] page, use the keyboard [Up], [Down], [Left], [Right] arrow keys to 

switch and select a single image. Use [Ctrl + mouse click] or [Shift + mouse click] to select 
multiple images at the same time. 
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Click the [Import Image Or Folder] icon in the upper right corner of the [Manage Images] 

page to import new images, and display them in the form of folders on the left [Layers] page. 

 
Click the [Images POS] icon in the upper right corner of the [Manage Images] page to import, 

export, and view image POS. 

Tips: 

 Import Image POS: select the image POS file from the local disk of the computer and 
import it, supporting .txt or .csv formats. 

 Export Image POS: Export the POS information of all images in the current project to the 
computer in .csv format. 
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 Image POS Preview: Click to preview the POS information of all current images. 

 

 
Right-click any image on the [Manage Images] page to perform four operations: [Show 

folder], [Focus], [Delete Images], and [Zoom In Images]. 

Notes: 

 [Show folder]: Click to open the local folder where the current image is located. 

 [Focus]: After clicking, the shooting location of the current image in the 2D view. 

 [Delete Images]: Click to delete the current image. If the image has been reconstructed, 
a window will pop up to confirm the deletion; if the image has not been reconstructed, it 
will be deleted directly. 
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 [Zoom In Images]: After clicking, you can view the image in full screen mode through 
[Large View]. 

 
Click the [Fullscreen] button in the upper right corner of the [Manage Images] page to 

switch the image management page to full-screen mode, and click the [Exit Full Screen] button 
in full-screen mode to exit the full-screen mode. 

 
In full-screen mode, images can be displayed in three ways: [Column Mode], [Gallery View], 

and [Large View]. 

In [Column mode], you can click the [-] icon or [+] icon in the upper right corner of the page 
to modify the number of image display columns. The default is 4 columns, which can be adjusted 
between 1-8 columns. 
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In full-screen mode, click the [Image List] icon in the upper left corner of the page to choose 
to display or hide the list of media. 

Click the Delete icon in the image list page to delete the image. 

Note: 

 The [Focus] function is not supported by right-clicking in fullscreen mode, however other 
operations are the same as in non-fullscreen mode. 
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1.3 Map View 

After adding the image, you can view the camera's track points in 2D view, the largest point 
becoming the initial position. 

Click the [2D] or [3D] icon in the lower right corner of the view page to switch between 2D 
or 3D view. 
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1.3.1 2D View 

Click the [Multiple Choice] icon in the upper right corner of the 2D view to enter the single 
selection mode. At this time, you can click to select any track point in the view. 

Notes: 

 The color of the selected track point will turn blue. 

 After selecting any track point, it will automatically locate the corresponding image file 
name on the [Layers] page on the left and the image on the [Manage Images] page on 
the right. 
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Click the [Select camera] icon in the upper right corner of the 2D view to enter the marquee 

mode. At this time, you can select multiple adjacent track points in the view through a 
rectangular selection area. 

Notes: 

 The color of the selected track point will turn blue. 

 After selecting multiple track points, the corresponding image file name on the [Layers] 
page on the left and the image on the [Manage Images] page on the right will be 
automatically linked. 

 Only the 2D view supports the [Select camera] function. 

 When hiding all the track points in the view on the [Layers] page, the [Select camera] 
icon is grayed out and cannot be clicked, and the [Select camera] function cannot be 
enabled. 
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After selecting the track point, click the [Delete selected camera] icon to delete the selected 

track point. 

Notes: 

 After clicking the [Delete selected camera] track point, the corresponding images in the 
[Layers] page and [Manage Images] page will be deleted synchronously. 

 When the track point is not selected, the [Delete selected camera] icon is grayed out and 
cannot be clicked. 

 
Click the [Center] icon in the lower right corner of the 2D view to focus the viewing angle on 

the center of the track point. 
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Click the [Zoom In] and [Zoom Out] icons in the lower right corner of the 2D view to zoom 

in or zoom out the viewing angle. 

 
Click the map icon in the lower right corner of the 2D view to switch the map background, 

supporting satellite or electronic maps. 
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When the mouse moves in the 2D view, the coordinate value of the current mouse position 

will be displayed in the bottom coordinate system bar below the view. For details, please refer 
to section 4.3 of this chapter. 

After the reconstruction process is completed, when [DSM] is checked in the [Result] 
column on the left [Layers] page, the DSM will be displayed synchronously on the 2D view page, 
and the relevant elevation legend color blocks will be displayed on the bottom left of the view. 
By sliding the control color block left and right, you can adjust the elevation range displayed by 
DSM. 

Notes: 

 The default coverage of the elevation legend is from the lowest altitude to the highest 
altitude of the project's imagery data. 

 When adjusting elevation, uncovered areas will be hidden in the DSM. 
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1.3.2 3D View 

The pose angle of the camera can be checked in a 3D view. 

Click the [Multiple Choice] icon in the upper right corner of the 3D view to select any track 
point in view. 

Notes: 

 The color of the selected track point will turn blue. 

 After selecting any track point, it will automatically locate the corresponding image file 
name on the [Layers] page on the left and the image on the [Manage Images] page on 
the right. 
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After the reconstruction is complete, check the [Tie Points] and [Rays] in the [Layers] page, 

and when the mouse hovers over the sparse point cloud, these can be enlarged. 

 
When the mouse clicks on a sparse point, it will connect the sparse point and all associated 

POS points with a ray, and display a thumbnail of the POS point. 
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Clicking any point on the dense point cloud or 3D model with the mouse will also associate 

all relevant POS points with rays, and display the thumbnail of the POS point. 
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Click the [Model Auto Rotate] icon in the lower right corner of the 3D view, and the scene 

will rotate the map clockwise according to the relative position and orientation of the current 
camera and the view data center. You can click the [Model Auto Rotate] icon again or drag the 
mouse in the view or scroll the wheel to zoom out of the model auto-rotate as you wish. 

 
Click the [Perspective] icon in the lower right corner of the 3D view to see through the 3D 

results. 
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Click the [Aerial View] icon in the lower right corner of the 3D view to view the entire 3D 

result from top to bottom. 

 
Click the [3D View Setting] icon in the lower right corner of the 3D View to expand the 3D 

View Settings page. 

Notes: 

 Dot Size: The size of point clouds can be adjusted. 

 Camera Size: You can adjust the size of the camera displayed in the 3D view. 

 Background: You can switch the background of the 3D view to black, gray, and white. 
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 3D Map: 3D map, can be switched on/off. 

 Sky: The sky can be switched on/off. 

 Center: When enabled, the coordinate axis of the ENU coordinate system with the view 
data center as the origin is displayed, and the camera is always locked at the local center, 
with the scene only able to be rotated or zoomed in/out. 

 
[Compass] Icon: Located in the lower left corner of the view, the red pointer points to the 

true north of the current 3D view. 

 
[Rotating Cube] 3D icon: Located in the lower right corner of the view, it can be used to 

manipulate the data observation angle in the 3D view. 
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Notes: 

 Coordinate axis: Display the orientation of the coordinate axis of the data ENU 
coordinate system in the current 3D view. 

 Six sides: Click any side of the [Rotating Cube] with the mouse, and the data will be 
observed from the front, back, left, right, top, bottom, and front sides according to the 
current position and attitude of the camera and data center. 

 Twelve edges: Click any edge of the [Rotating Cube] with the mouse, and observe the 
data from the middle position between the two sides of the edge according to the current 
position and attitude of the camera and the data center. 

 Eight vertices: Click any vertex of the [Rotating Cube] with the mouse, and observe the 
data from the effective orientations specified. 

 Other interactions: double-click the "face, edge, vertex" of the [Rotating Cube] to restore 
the initial perspective of the 3D view, and drag the cube to rotate with the mouse. 

 
 

1.4 Layers 

After adding an image, the image will be automatically displayed in the [Camera] column on 
the [Layers] page, and all images support [Focus] and [Delete] operations. 

[Focus]: Hover the mouse over an image in the [Camera] column and click the [Focus] icon 
or right-click on the image and select [Focus] to automatically focus on the image in the view. 

[Delete]: Hover the image in the [Camera] bar and click the [Delete] icon or right-click the 
image and select [Delete] to delete the selected image. 
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Search layer: Enter the name of a layer, folder, or image in the search bar on the [Layers] 

page to search and display the corresponding results under the current item. 

 
Use [Ctrl + mouse click] or [Shift + mouse click] in the [Layers] page to select multiple 

images at the same time. 
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2. Importing Image POS Data 

2.1 Image POS Data Overview 

The image POS data records the geographic location, attitude angle information and other 
auxiliary positioning information of each image. Accurate POS data can improve the 
reconstruction speed and result accuracy, and can also avoid incorrect reconstruction results or 
even reconstruction failures due to POS data problems. 

Note: 

The images taken by Autel drones will write the POS data into the image by default, users 
do not need to manually import POS data in this case. 

 

2.2 Checking POS Data 

Before importing images, check whether the images have built-in POS information. 

This can be achieved by: 

1) Right-click the image to be imported in the computer, select [Properties], click [Details], 
and find the [GPS] column from the pull-down. 

2) If the [GPS] column is found and the specific latitude, longitude, and altitude are 
displayed, the image contains POS information, and there is no need to manually import 
POS data again. 

3) If the [GPS] column is not found, it means that the image has no POS information, and 
the POS data needs to be imported manually. 
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2.3 Importing Image POS Data 

2.3.1 Prepare POS files 

Autel Mapper supports importing image POS files in txt format and csv format. 

Notes: 

The POS file needs to include: image name (absolute path + image name and format), 
longitude (X), latitude (Y), altitude (Z) and other information. 

The image name contained in the imported image POS file must be consistent with the name 
and storage path of the actual image. 

Tips: 

 Users can export the POS file of the image with built-in POS information in Autel Mapper 
in advance, and then make the required POS file according to the exported POS file 
format, so as to avoid the failure of POS file import due to format errors. 

 Method 1: After importing the image with built-in POS information in the project, click 
[Edit->Image Position and Attitude] to open the image position and attitude data page, 
and click the [Export POS] button to obtain the POS file. 

 Method 2: After importing the image with built-in POS information into the project, click 
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the [Images POS] button on the image management page and select [Export image POS] 
to obtain the POS file. 

 

2.3.2 Setting POS Parameters 

 Using RTK to locate photos, the horizontal accuracy is 0.03m and the vertical accuracy is 
0.06m. 

Notes: 

 Phase-free data must be set to this item, otherwise it will have a great impact on the 
accuracy of the results. 

 Using non-RTK positioning photos, the horizontal accuracy must be 2m and the vertical 
accuracy 10m. 

For image POS data in .csv format, please refer to the figure below: 

 
The image POS data in .txt format can use the following figure as an example: 

 
Tips: 

 For image POS files in txt format, it is recommended that the data in each line be 
separated by English commas (,), and the decimal points be represented by (.). 

 

2.3.3 Importing POS Files 

In Autel Mapper, image POS files can be imported for projects in the following ways. 

 Click the [Images POS] icon in the upper right corner of the [Manage Images] page and 
select [Import image POS] to import. 
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 Click [File->Import Image POS] in the menu bar to import. 

 

 Click [Edit->Image Position and Attitude] in the menu bar to open the [Image position 
and attitude data] page, and click the [Import POS] icon to import. 
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In the [File reading mode] column, set [Ignore the first few lines of the file], [Decimal 

separator], [Column delimiter], and [The sequential separator is a single process] according 
to the format of the imported POS file. 

Tips: 

 The data in the [Image position and attitude] list is displayed according to the set [File 
reading mode] rules. 

 [Ignore the first few lines of the file] is used to eliminate invalid data in the header. 

 [Decimal separator] is used to set the display form of the decimal point. 

 [Column delimiter] is used to set the separation form between multiple forms of data in 
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each row. 

 [The sequential separator is a single process] is used to eliminate repeated symbols 
between two data. 

 
In the [POS Coordinate System] column, you can set the horizontal coordinate system, 

elevation coordinate system and elevation offset. 

Tips: 

 [Horizontal Coordinate System]: It supports the selection of ground coordinate system 
and projection coordinate system; if you import a custom POS, you can click the [Import 
PRJ] button to set this. You can query and select different horizontal coordinate systems 
in the horizontal coordinate system drop-down menu. 

 [Vertical Coordinate System]: The elevation coordinate system is the default value, and 
the user can manually change it according to the actual situation. Different elevation 
coordinate systems can be selected in the elevation coordinate system drop-down menu. 

 [Vertical Deviation]: It is mainly used to increase or decrease the overall height. When 
there is an error between the ellipsoid height and the altitude, you can adjust the ellipsoid 
height to the altitude by setting this parameter. 
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In the [Attitude angle] column, you can select the attitude angle information, which 

supports Yaw, Pitch, Roll format and Omega, Phi, Kappa format attitude angle. 

 
In the [POS Data Accuracy] column, you can set the precision type, including four types: 

Autel Default  Accuracy, RTK Accuracy, Non-RTK Accuracy, or Custom Accuracy. 



48   

 Autel Mapper User Manual  

 
In the [Image position and attitude] list, you can modify the header of each column to make 

it correspond to the value in the column. 

Tips: 

 Image name, longitude (X), latitude (Y), altitude (Z) are required values, and the same 
header cannot be selected. 

 When the selected coordinate system is a ground coordinate system, it displays longitude, 
latitude, and height; when the selected coordinate system is a projection coordinate 
system, it displays X, Y, and Z. 

 After importing the image POS file, click the [Preview] button to preview the latest image 
POS data. 

 After checking that the image POS data is correct, click the [Confirm] button to complete 
the image POS data import. 
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3. Camera Management 

Camera management includes modifying camera parameters, adding templates, importing 
templates, exporting templates, and managing templates. 

 

3.1 Modifying Camera Parameters 

Autel Mapper supports automatic identification of camera parameter information built into 
images. When there is a problem with the built-in camera parameters of the image or the lack 
of camera focal length information in the camera parameters makes it impossible to perform 
reconstruction processing, etc., it is necessary to manually modify the camera parameters 
before reconstruction processing. 

Click [Edit->Camera Parameters] in the menu bar to open the [Camera Parameters] page. 
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Select the [Camera] column on the left side of the [Camera Parameters] page, and select 

the camera in the camera list below to modify the parameters of the selected camera in the 
[Camera Parameters] column and [Intrinsics] column on the right. 

 
Select the [Folder] column on the left side of the [Camera Parameters] page to display 

camera categories in the form of image folders. After selecting a folder, you can uniformly modify 
the camera parameters of the images in the entire folder. 
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After modifying the camera parameters, the suffix "_custom" will be added after the current 

camera name. You need to click the [Apply] button to use the processed parameters in the 
reconstruction. 

 
In the [Camera Parameters] column, click [Camera Name] to select a preset camera 

template from the drop-down menu. Please make sure that the selected camera parameters are 
correct. 
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3.2 Adding A Template 

Click the […] icon in the upper right corner of the [Camera Parameters] page to perform 
four operations: [Add Current Template], [Import A Template], [Export A Template], and 
[Templates]. 

 
When the camera parameters are modified and the [Apply] button is not clicked, [Add 

Current Template] is grayed out and cannot be clicked. 
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After saving the camera parameters, click [Add Current Template], and the corresponding 

pop-up window will pop up, enter the template name in it and click the [Add] button to complete 
the addition. 

Note: 

 The entered template name cannot be the same as an existing template. 
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After the addition is successful, the [Camera Name] in the [Camera Parameters] column is 

also changed to the name of the added template. The camera template can be seen in the drop-
down menu, and the camera template can also be used in other project pages. 

 
 

3.3 Importing A Template 

Click the […] icon in the upper right corner of the [Camera Parameters] page and select 
[Import A Template] to import the camera template file. 

Tips: 

 Camera template files only support .json format. 
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3.4 Exporting A Template 

Click the […] icon in the upper right corner of the [Camera Parameters] page and select 
[Export A Template] to export the camera template file. In the pop-up [Export the Camera 
Parameter Template] pop-up window, select the template and the export path, and click the 
[Export] button to export the camera template to the local disk of the computer. 

Notes: 

 Only templates in the camera template library are exported. 

 The exported template is in .json format and cannot be modified. 
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3.5 Managing Templates 

Click the […] icon in the upper right corner of the [Camera Parameters] page and select 
[Templates] to view all camera templates. 

 
The camera template library is divided into [Custom] templates and [Intrinsics] templates. 

In the camera template library, [Custom] templates can be deleted and edited. 
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The [Intrisics] template only supports viewing camera parameter information, and cannot 

be edited. 

 
 

4. Setting the Project Output Coordinate System 

4.1 Project Output Coordinate System Overview 

During 2D reconstruction and 3D reconstruction, the user can set the project output 
coordinate system in the [Project Output Coordinate System] column of the [Process Settings] 
page. The default coordinate system is a projection coordinate system from the recognized 
photo, and the ground control point (GCP) coordinate system and the project output coordinate 
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system are consistent with this. 

After setting the project output coordinate system, the coordinate system of OSGB, DOM 
and DSM output for 2D and 3D reconstruction will also be synchronized to the set coordinate 
system. 

 
 

4.2 Setting Coordinate System 

Click the [Project Output Coordinate System] button on the [Process Settings] page to 
expand the project output coordinate system setting bar. 

Note: 

 Arbitrary Coordinate System: The [Arbitrary Coordinate System] option is grayed out 
and cannot be modified in the current version. 

 Horizontal Coordinate System: Automatically identify the projection coordinate system 
corresponding to the photo, the horizontal coordinate system can be modified through 
the drop-down menu, and it supports modification to a ground coordinate system or a 
projected coordinate system. 

 Vertical Coordinate System: The default elevation coordinate system is the geoid, and it 
supports modification to other elevation coordinate systems. 

 Geoid: After modifying the elevation coordinate system, the corresponding geoid can be 
selected according to the selected elevation coordinate system. 
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Click [Edit->GCP Manager] in the menu bar, enter the [GCPs Manager] page, import the 

ground control point file, and then modify the coordinate system of the ground control point file, 
you can also modify the project output coordinate system. 
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4.3 Horizontal Coordinate System 

The horizontal coordinate system defaults to the WGS 84/UTM projection coordinate system. 

Tips: 

 The default coordinate system may be different for different images. 

After modifying the project output coordinate system to EPSG:32649, the coordinate system 
at the bottom also becomes EPSG:32649 synchronously, and the geographic information at the 
bottom becomes X, Y, Z (projected coordinate system values). 
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  Reconstruction Process 
 

This chapter mainly introduces the related reconstruction process of Autel Mapper, 
including aerial triangulation, point clouds, 3D reconstruction and 2D reconstruction. 
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1. Reconstruction Introduction 

Reconstruction includes 2D reconstruction and 3D reconstruction, in which 2D 
reconstruction can generate a digital surface model (DSM) and digital orthophoto (DOM) of the 
photographed area. 3D reconstruction produces a 3D model. 

 

2. Aerial Triangulation 

2.1 Aerial Triangulation Introduction 

Aerial triangulation refers to the use of the spatial geometric relationship between the aerial 
image and the captured object in photogrammetry to calculate the position and attitude of the 
camera at the moment of camera imaging and the sparse point cloud of the captured object 
through the corresponding relationship between the image point and the captured object. 

After processing aerial triangulation, it is possible to quickly judge whether the quality of the 
original data meets the project delivery requirements and whether images need to be added or 
deleted. 

Both 2D and 3D reconstruction must rely on the result of aerial triangulation, so it must be 
processed by this method first. During the reconstruction process, on the [Process Settings] 
page, it can be configured to process together with the aerial triangulation, or processed first, 
and then the 2D or 3D reconstruction is performed separately. 

 

2.2 Aerial Triangulation Processing 

2.2.1 Aerial Triangulation Selection 

 Click the [Process Settings] icon to switch to the [Process Settings] page, and check the 
[Aerial Triangulation] option. 

 Click [Process->Aerial Triangulation] on the menu bar and check the [Aerial 
Triangulation] option. 

Note: 

 The [Aerial Triangulation] option is checked by default before the aerial triangulation 
process and cannot be unchecked by graying it out. 

 The output format of the aerial triangulation is in .XML format and cannot be cancelled. 
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2.2.2 Aerial Triangulation Steps 

1. [Aerial Triangulation] is checked by default after creating a new project, and it cannot be 
unchecked. 

2. In the [Process Settings] page, after [Aerial Triangulation] is checked by default, click the 
[Start Processing] button. 

3. During the processing, you may click [Stop] button to cancel any processing. After 
stopping, you can modify the image, coordinate system, POS and other information and 
start processing again. 
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When processing starts again after stopping, processing will continue on the same basis. 

After the aerial triangulation processing is completed, sparse point clouds and rays are 
generated. At this time, [Aerial Triangulation] can be unchecked, and this isn’t needed 
subsequently. 

 
 

2.2.3 Aerial Triangulation Results 

After the aerial triangulation process is completed, the result will be generated in the task 
subfolder of the project folder, and the processed result file is as shown in the figure below. 
Among them, sfm.xml is the output result file. 
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2.3 GCP Manager 

2.3.1 GCP Introduction 

Ground control point (GCP) is a marked point with obvious characteristics on the ground, 
and the geographic information generated by the image can be adjusted through it. 

When conducting UAV aerial survey operations, you can use RTK, total station and other 
measurement tools to obtain iconic real coordinate points in the photographed area, and then 
compare the real coordinate points with the photographed area by importing GCPs and marked 
points. The point in the image is associated to adjust the coordinate system of the point and 
improve the precision and accuracy of the aerial triangulation. 

Note: 

 Ground control points are divided into control points and checkpoints. The control points 
are mainly used to optimize the accuracy of the aerial triangulation and improve the 
accuracy of the model; the checkpoints are mainly used to check the accuracy of the 
aerial triangulation, so as to measure the aerial triangulation results. 

 

2.3.2 Using GCPs 

Before importing any GCPs, you need to log in to Autel Mapper, otherwise the [GCP Manager] 
function will be grayed out and cannot be used. 
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Note: 

 GCP files support .txt format and .csv format. 

 For files in .txt format, it is recommended that the data in each line be separated by English 

commas (,), and the decimal points be represented by (.). 

 The GCP file must contain: 

1) Ground coordinate system: name, longitude, latitude, altitude. 

2) Projection coordinate system: Name, X, Y, Z. 

 GCP files can import horizontal precision and vertical precision, or not. If not imported, 
the default value is 0.005. 

An example in .csv format is pictured below: 

 
An example in .txt format is pictured below: 
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Ways to import GCP files: 

Click the [GCP Manager] button on the [Process Settings] page or the menu bar [Edit->GCP 
Manager] to enter the [GCPs Manager] page. 

Click the [GCPs File] button on the [GCPs Manager] page to import the file from the local 
disk of the computer. 

 
Drag and drop the ground control point file from the local disk of the computer to the [GCPs 

Manager] page to complete the import. 
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After adding the ground control point, click the [Import GCP] icon on the right side of the 

[GCPs] list on the [GCPs Manager] page to import the file. 

 
In the [File reading mode] column, set [Ignore the first few lines of the file], [Decimal 

separator], [Column delimiter], and [The sequential separator is a single process] according 
to the format of the imported GCP file. 

Notes: 

 The data in the [GCP Data column definition] list is displayed according to the set [File 
read mode] rules. 

 [Ignore the first few lines of the file] is used to eliminate invalid data in the header. 
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 [Decimal separator] is used to set the display form of the decimal point. 

 [Column delimiter] is used to set the separation form between multiple data forms in 
each row. 

 [The sequential separator is a single process] It is used to eliminate repeated symbols 
between two data. 

 
In the [GCP Coordinate System] column, you can set the horizontal coordinate system, the 

vertical coordinate system and the geoid. 

Tips: 

 [Horizontal Coordinate System]: supports selection of ground coordinate system and 
projection coordinate system; if you import a custom GCP, you can click the [Import PRJ] 
button to set. You can query and select different horizontal coordinate systems in the 
horizontal coordinate system drop-down menu. 

 [Vertical Coordinate System]: The elevation coordinate system is the default value, and 
the user can manually change it according to the actual situation. Different elevation 
coordinate systems can be selected in the elevation coordinate system drop-down menu. 

 [Geoid]: Geoid is the default value. After modifying the elevation coordinate system, the 
corresponding geoid can be modified. 
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You can set the precision type in the [GCP Data Accuracy] column, including using default 

accuracy or a custom accuracy. 

Notes: 

 [Default accuracy], the default accuracy is 0.005 for horizontal and vertical precision. 

 [Custom accuracy], the imported accuracy is used as the precision of the GCP file. 

 
In the [GCP Data column definition] list, you can modify the header of each column so that 

it corresponds to the value in the column. 

Tips: 
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 Name, Longitude (X), Latitude (Y), Altitude (Z) are required values, and the same header 
cannot be selected. 

 When the selected coordinate system is a ground coordinate system, it displays longitude, 
latitude, and height; when the selected coordinate system is a projection coordinate 
system, it displays X, Y, and Z. 
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Add a single handle: 

Click the [+] icon in the upper right corner of the [GCPs Manager] page and add a line of 
ground control points to be input in the [GCPs] list. After entering the information, it will be 
added immediately. 

 
Inputting GCP information: 

 Mark: Number of marks marked, input not supported. 

 Type: The type is divided into control point and checkpoint. The default is control point, 
which can be modified to checkpoint. 

 Name: The name of the image handle needs to be unique. 
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 Longitude: Enter the longitude of the control point. 

 Latitude: Enter the latitude of the control point. 

 Altitude: Enter the height of the control point. 

 Horizontal Accuracy: The horizontal accuracy is 0.005 by default and can be modified to 
an accurate accuracy. 

 Vertical Accuracy: The vertical accuracy is 0.005 by default and can be modified to 
accurate accuracy. 

 Reprojection Error Value: The point is automatically calculated after marking more than 
two points, input is not supported. 

 3D Point Error: The point is automatically calculated after marking more than two points, 
and input is not supported. 

 
To edit a single GCP: 

 Click any ground control point in the [GCPs] list to enter the edit mode of the ground 
control point. You can modify the ground control point type, name, longitude, latitude, 
height, horizontal precision, vertical precision. 

 When the edited ground control points have been marked and reoptimized, the 
punctuated points of the original ground control points will be deleted after editing and 
all the result files will be deleted (except the results of aerial triangulation). 
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To edit multiple GCPs: 

 Add additional pins by importing new pin files. 

 When the imported image handle has the same name as the existing image handle, the 
original image handle will be overwritten. 

 Edit ground control point information by modifying [File reading mode], [GCP 
Coordinate System], [GCP Data column definition]. 

 When the edited ground control point includes the control point that has been marked, 
and has been reoptimized, the original will be deleted after editing. 

 
Export the mark file: 
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 After the control points have been created, click the [Export Mark file] icon in the upper 
right corner of the [GCPs Manager] page to export the mark file of the ground control 
points. 

 The export format is in .json format. 

 The exported control point includes: name, longitude (X), latitude (Y), height (Z), type, 
horizontal accuracy, vertical accuracy, reprojection error value, 3D point error, marked 
point information, and GCP coordinate system. 

 
Delete a single GCP: 

 Select any ground control point in the [GCPs] list and click the [-] icon in the upper right 
corner of the [GCPs Manager] page to delete it. 

 When the deleted ground control points have been marked and reoptimized, the results 
will be deleted simultaneously. 
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Delete multiple GCPs: 

 Click the plus icon in the upper right corner of the [GCPs Manager] page and select [Clear 
GCP List] to delete in batches. 

 When there are marked points in the ground control points and have been reoptimized, 
all the results will be deleted. 
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2.4 Marked Points And Re-optimization 

2.4.1 Marked Points Description 

The punctuated point is to mark the real geographic coordinates of the collected ground 
control point to the corresponding position in the image associated with this point, so as to 
adjust the geographic information of the photo; whether it is a control point or a checkpoint, if 
it is to work, it needs to be done mark point operation. 

 

2.4.2 Marked Points And Re-optimization Processes 

The process of marking point and re-optimization is mainly:  

Aerial Triangulation -> Import GCP -> Marking Points -> Re-optimization. 

 

2.4.3 Using Image Marks 

In the [GCPs Manager] page, click any ground control point in the [GCPs] list on the right to 
enter the marking mode of the ground control point, and automatically click on the [Image 
Gallery] column in the [Image Marks] sub-page on the left. Display the image associated with 
the GCP, and display the calculated GCP position in the associated image with a [Blue ×] mark. 

Tips: 

 [Blue ×] marks the calculated ground control point position, which may deviate from 
the actual position. 

 
Use the mouse wheel to enlarge the selected image. After zooming in, click the point where 

the ground control point is actually located in the image to mark the point. The marked point 
will be displayed as a [Green +] mark. 
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Slide the scale on the upper right side of the [Image Marks] subpage to adjust the zoom 

factor of the image displayed in the lower window. 

 
Click the [Reset Size] icon to restore the image to the default display size of the window. 
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Click the [Focus] icon to focus the image on the pierced point and display it in the center 

with the current zoom factor. 

 
Click the [Maximize] button to switch to full-screen mode and perform marking. 

Note: 

 After entering the full-screen mode, the [Maximize] button becomes the [Minimize] 
button, which can be restored to the original page size after clicking. 
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After marking, the number of markers, reprojection error value, and 3D point error value of 

the corresponding control point will be automatically displayed in and below the [GCPs] list. 

 
Deleting a single mark: 

 Right-click the marked image and select [Delete the Image Mark] or click the [Delete the 
Image Mark] icon in the upper right corner of the image display window to delete the 
mark of the current image only. 
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Delete multiple marks: 

 Click the [Clear all marks of the image control point] icon in the upper right corner of 
the [Image Marks] subpage to clear all marks of the ground control point. 

 
Remove all marks: 

 Click more icons in the [GCPs] list and select [Delete All Marks] to delete all marks of all 
ground control points. 
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Auto-marking: 

 After manually marking two points on the ground control point, you can click the [Auto 
mark other images] icon in the upper right corner of the window to perform automatic 
marking on all the remaining images associated with the ground control point. 

 
 

2.4.4 Re-optimization 

When two or more points are marked by one image control, the [Reoptimize] button under 
the [GCPs] list becomes clickable. 
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Tips: 

In order to ensure the accuracy of re-optimization, it is recommended to mark all images 
associated with all ground control points in the [GCPs] list before re-optimization. 

 
 

2.5 Layer Tree, Map View 

2.5.1 Layer Tree 

After performing Aerial Triangulation, generate sparse point clouds and rays, and the sparse 
point clouds are displayed under the [Tie Points] layer in the [Layers] page. 

Sparse point clouds and rays can only be selected from [Show] or [Hide], and cannot be 
deleted manually. 
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2.5.2 Map View 

Check [Sparse Point Cloud] to display the generated sparse point cloud in the map view. 

Check [Sparse Point Cloud], [Rays], [Camera], click any sparse point to see the ray displayed 
between the sparse point and the image. 

 
Check [GCPs], [Rays], [Camera], and click any control point to see the ray displayed between 

that point and the image. 
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2.6 Aerial Triangulation Quality Report 

The aerial triangulation quality report is divided into a summary and a detailed analysis, with 
the latter showing a comprehensive report. 

 

2.6.1 Summary 

Click the [Quality Report] icon in the upper right corner of the project page to open the 
quality report summary page. 

Aerial Triangulation, GCPs errors, and check points errors will be displayed on the [Quality 
Report] summary page. 
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2.6.2 Details 

To open the comprehensive report, complete the following steps: 

 When the processing is successful, click [Open Quality Report] in the pop-up prompt box. 

 Click the [Detail] button in the [Quality Report] summary page. 

 Click on the menu bar [Process->Open Quality Report]. 
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Description of Aerial Triangulation Quality Report: 

 GSD: Ground resolution is the ability to identify the minimum size of ground objects on 
the image. 

 Coordinate System: The coordinate system is the default WGS 84. If the GCP/project 
output coordinate system is modified, only empty three is processed, and the coordinate 
system is still the default value. 

 Calibrated Images: The number of images that can be used to actually generate a sparse 
point cloud. If the number is less than the number of imported images, it means that 
there are images that cannot be used to generate a sparse point cloud. If the area where 
the image is captured is mainly texture-free or weakly textured, or the area where the 
image and other images do not overlap, calibration may not be possible, and aerial 
triangulation must be performed after re-shooting. 

 Error Rate of GCP Marks Used: This error represents the error value between the 
imported control point and the actual calculated geographic location. The smaller the 
value, the more accurate the location. 

 Camera Calibration: Camera calibration information mainly checks the change values of 
focal length f, image principal point x, and image principal point y before and after aerial 
triangulation of the camera. Generally, the change value does not exceed 50 pixels. 

 Average Optimization Rate Of Camera: The change value of the camera focal length/the 
initial value of the camera focal length, which represents the optimization ratio of the 
front and rear cameras of the aerial triangulation. If the value is too large, it means that 
the camera has changed a lot, and the reason needs to be analyzed; if the images used 
for aerial triangulation are all orthographic or oblique, you can add images from different 
shooting angles. 
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2.6.3 Export A Quality Report 

On the [Quality Report] summary page, you may export a quality report to the local disk of 
the computer. 

Click the [Export] button in the quality report details to export the quality report to the local 
disk of the computer. 

Note: 

 The exported quality report format is in .PDF. 
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When exporting a quality report, you can click the [Cancel] button to cancel the export. 

 
 

3. Dense Point Cloud 

3.1 Dense Point Cloud Overview 

Dense point clouds are carried out following the results of aerial triangulation, mainly to 
increase the number of extracted points with the same name and improve the connectivity of 
images. 

The reconstruction quality of dense point clouds is divided into three levels: high, medium 
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and low. Generally, the appropriate dense point cloud method is selected according to the 
results of aerial triangulation. When there is a high amount of weak textures, high-quality is 
generally used, but this method has a large amount of data and therefore takes a long time to 
process. 

Dense point clouds can solve lacking a number of points with the same name in weak areas 
and the inability to match between points with the same name. It can effectively avoid holes and 
deformations in the 3D model, and ultimately improve the accuracy and quality of the 3D model. 

 

3.2 Using Dense Point Clouds 

3.2.1 Dense Point Cloud Configuration 

Reconstruction quality is divided into three levels: high, medium and low, and the default is 
medium quality. With different reconstruction qualities, the number of generated point clouds 
is different, and the processing time will also be different. 

Notes: 

 High: The original resolution of the image. 

 Medium: 1/4 of the original resolution of the image, and 1/2 of the original image in width 
and height. 

 Low: 1/16 of the original image resolution, and 1/4 of the original image's width and 
height. 

Result Format: 

 PNTS format: LOD point cloud format, checked by default and must be checked, used for 
display in the program after generation. 

 LAS format: Non-LOD point cloud format, unchecked by default, can be checked. 

 XYZ format: Non-LOD point cloud format, unchecked by default, can be checked. 
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3.2.2 Dense Point Cloud Processing Steps 

These must rely on aerial triangulation results. It can be processed together with the aerial 
triangulation, or the dense point clouds can be processed separately after the aerial 
triangulation is completed. 

On the [Process Settings] page, check [Dense Point Cloud], and set the reconstruction 
quality and result format, and click the [Start Processing] button to start the reconstruction 
process. 

Note: 

 Dense Point Cloud is not checked by default and needs to be checked manually. 
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During the processing, you can click the [Stop] button to stop the processing, modify the 

reconstruction quality or the result format before processing, or restart the processing directly 
without modifying any parameters. 

 
After the processing is completed, you can view the results of the dense point cloud in the 

layer tree and 3D view of the [Layers] page. 
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3.3 View Results And Export 

3.3.1 View Results 

You can open the system directory where the result file is located through the menu bar 
[Process->Open Result Folder]. If no result (Dense point cloud, 3D result, 2D result) has been 
generated, [Open Result Folder] will be grayed out. 

 
You can also find the directory where the result file is located in the local disk of the 

computer according to the path where the project folder is located. 

In the result folder, you can see the pnts, las, xyz result folders. 
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Tips: 

 The tileset.json file in the pnts folder is the result of dense point cloud. After generating 
this file, it means that the pnts format of dense point cloud has been processed, and the 
frontend renders the result of dense point cloud in the program. 

 
 

3.3.2 Export Results 

Click [File->Export Dense Point Cloud] in the menu bar to export the results of dense point 
cloud. 
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On the [Layers] page, right-click [Dense Point Cloud] under the layer tree or click the [Export] 
icon on the right to export the results of dense point cloud. 

 
The export results support the option to export results in PNTS, LAS, and XYZ formats. 

Tips: 

 All existing output formats are checked by default. 

 If the corresponding result format is not checked during dense point cloud processing, 
the corresponding format cannot be selected when exporting. 
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3.4 Dense Point Cloud Quality Report 

After the dense point cloud is processed, the quality report details page will add dense point 
cloud processing information, including: Reconstruction Quality, Result Format, and Processing 
Time. 

 
 

4. 3D Reconstruction 

4.1 3D Reconstruction Overview 

3D reconstruction refers to the combination and splicing of the generated dense point cloud 
to generate a 3D model of the captured object. 

 

4.2 3D Reconstruction Processing 

4.2.1 3D Model Options 

The reconstruction quality is divided into three levels: high, medium and low, and the default 
is medium quality. With different reconstruction qualities, the definition of the generated 3D 
model is different, and the processing time will also be different. 

Note: 

 High: The original resolution of the image. 

 Medium: 1/4 of the original resolution of the image, and 1/2 of the original image in width 
and height. 

 Low: 1/16 of the original image resolution, and 1/4 of the original image's width and 
height. 

Result format: 

 B3DM format: LOD model format, checked by default and must be checked, used to 
display in the program after generation. 

 OSGB format: LOD model format, unchecked by default, can be checked. 

 OBJ format: Non-LOD model format, unchecked by default, can be checked. 

 PLY format: Non-LOD model format, unchecked by default, can be checked. 
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4.2.2 3D Model Processing Steps 

The 3D model depends on the results of the aerial triangulation, and the Aerial Triangulation 
can be performed first, and then the 3D model can be processed separately, or the aerial 
triangulation can be processed together with the 3D model. 

The 3D model and dense point cloud can be processed simultaneously or separately. 

On the [Processing Settings] page, check [3D Model], and set the reconstruction quality and 
result format, and click the [Start Processing] button to start the reconstruction process. 

Tips: 

 The [3D Model] column is not checked by default and needs to be checked manually. 

 If the Autel Mapper account is not logged in or the account validity period expires, or if 
the newly created project has not been run in aerial triangulation, the 3D model 
reconstruction function cannot be performed. 
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During processing, you can click the [Stop] button to stop processing, and modify the 

reconstruction quality or result format before processing. 

Check the [3D Model] in the layer tree on the [Layers] page, and view the results of the 3D 
model in the 3D view. 

 
 

4.3 Area of Interest 

The Area of interest reduces the running time of the task or improve the accuracy. Before 
running the 2D or 3D reconstruction task, enter the area of interest in the corresponding mode 
to draw an area of focus. After saving successfully, running the corresponding task will only 
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generate the area of interest in the results. 

Note: 

 The area of interest is a regular spatial polygon, and its surface is vertical or parallel to 
the plane. The default is a rectangular hexahedron. 

 

4.3.1 Using Area of Interest 

If you have not logged into the Autel Mapper account or the account validity period has 
expired, or if the newly created project has not completed aerial triangulation, the [Area of 
Interest/Block] button and the [DOM and DSM] buttons are grayed out and cannot be entered. 

 
When logging in to the Autel Mapper account and the account is within the validity period, 

click the [Area of Interest/Block] button under the [3D Model] in the [Process Settings] page to 
enter the [3D Model Area of Interest Settings/Block] page, click  [Area of Interest Settings] 
button under [DOM and DSM] in the [Process Settings] page to enter the [DOM and DSM Area 
of Interest Settings] page. Alternatively, click [Edit->3D Model Area of Interest Settings/Block] 
and [Edit->DSM & DOM Area of Interest Settings] on the project page to enter the [3D Model 
Area of Interest Settings/Block] page and [DOM and DSM Area of Interest Settings] 
respectively. 
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4.3.2 Get An Automatic Area of Interest 

When entering an area of interest for the first time, an automatic area of interest is 
generated by default. If the area of interest is cleared, if you want to get an automatic area of 
interest, you can click the [Auto] button in the [Area of Interest Settings] column on the right. 

 
 

4.3.3 Acquire Largest Area of Interest 

Click the [Max.] button in the [Area of Interest Settings] column on the right to clear the 
current area of interest and draw the largest area of interest. 
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Note: 

 According to the range of the largest bounding box of the sparse point cloud generated 
by the imported image, Autel Mapper will generate the largest area of interest. 

 
 

4.3.4 Clear Area of Interest 

Click the [Clear the area] icon in the upper right corner of the [3D Model Area of Interest 
Settings/Block] page to clear the area of interest. 
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4.3.5 Add Vertex 

After clicking the [Edit the Point] icon in the upper right corner of the [3D Model Area of 
Interest/Block] page, you can continuously click the mouse in the view to customize the 
boundary vertices of the area of interest. 

Tips: 

 At least three vertices in different positions are required to generate the top surface of 
the area of interest. 

 The selected vertex color changes to blue. 
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4.3.6 Move Vertices 

Select the vertices to be moved on the [3D Model Area of Interest Settings/Block] page, 
press and hold the left mouse button and move the mouse to move the selected vertices. 

 
 

4.3.7 Delete Vertex 

Select the vertices to be deleted on the [3D Model Area of Interest Setting/Block] page, and 
click the [Delete the selected point] icon in the upper right corner to delete the selected vertices. 

Tips: 

 After deleting a vertex, the remaining vertices automatically generate a new top surface 
of the area. 

 When the number of vertices in the view is deleted to less than 3, the generated area of 
interest disappears. 
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4.3.8 Edit Area of Interest Polygon 

Click the [Auto] or [Max.] button in the [Area of Interest Settings] column to generate an 
area of interest. 

Then click the [Edit the Area of Interest] icon in the upper right corner of the [3D Model 
Area of Interest Settings/Block] page to edit the area of interest surface. At this time, the area 
of interest view will automatically adjust the 3D perspective. 

Note: 

 The boundary of the area of interest must be parallel to the latitude and longitude 
direction before it can be edited. When editing, you can drag the selected surface. 

 Currently, editing the area of interest only supports the adjustment of the area of interest 
under either automatic area or maximum area. 
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Move the mouse to the area you want to adjust, the area will be highlighted, press and hold 

the mouse and move the mouse in the direction to be adjusted, the geometry formed by the 
area of interest will change in the corresponding direction, release the left mouse button to stop 
the current movement. 

 
Tips: 

 All six faces of the geometry formed by the area of interest support edit movement. 

 Turn the [Rotating Cube] in the lower right corner of the view to adjust the stereoscopic 
perspective of the area. 
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4.3.9 Mobile Area of Interest 

Click the [Move the Area of Interest] icon in the upper right corner of the [3D Model Area 
of Interest Settings/Block] page to enable the function of moving the area. 

 
Place the mouse on the area of interest, it will become highlighted, press and hold the left 

mouse button, move the mouse in the direction you want to move the area of interest, release 
the left mouse button to stop. 
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4.3.10 Importing KML 

Click the [Import] button in the [Area of Interest Settings] column, select a KML file with a 
point within the range of the imported image, and draw the corresponding area of interest based 
on the KML. 

 
 

4.3.11 Adjust Longitude, Latitude, Height 

Enter the corresponding values in the [Longitude], [Latitude], and [Height] text boxes below 
the [Area of Interest Settings] column, and the area of interest can be redrawn according to the 
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filled values. 

Tips: 

 Adjusting longitude, latitude and height only supports the adjustment of area under Auto 
Area and Max Area. 

 
 

4.3.12 Copy An Area of Interest 

After drawing the area of interest in 3D mode, click the [Copy the area to DSM & DOM] 
button at the bottom of the [Area of Interest Settings] column to apply the drawn area of 
interest to the area of interest of the 2D model. 

Note: 

 When copying regions to DSM and DOM, only polygonal areas with four or more sides 
are supported. 
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After drawing the area of interest in 2D mode, click the [Copy the area to 3D Model] button 

at the bottom of the [Area of Interest Settings] column to apply the drawn area of interest to 
the area of interest of the 3D model. 

 
 

4.3.13 Toggle Show/Hide Camera 

Click the [Show/Hide Camera] icon in the upper left corner of the [3D Model Area of 
Interest Settings/Block] page or the [DOM and DSM Area of Interest Settings] page to control 
whether the camera is displayed or hidden in the view. 
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4.3.14 Toggle Show/Hide Sparse Point Clouds 

Click the [Show/Hide Sparse Point Cloud] icon in the upper left corner of the [3D Model 
Area of Interest Settings/Block] page or the [DOM and DSM Area of Interest Settings] page to 
control the display or hiding of sparse point clouds in the view. 

 
 

4.3.15 Toggle Show/Hide Areas of Interest 

Click the [Show/Hide the Area of Interest] icon in the upper left corner of the [3D Model 
Area of Interest Settings/Block] page or the [DOM and DSM Area of Interest Settings] page to 
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control whether the area is displayed or hidden in the view. 

 
 

4.3.16 Save An Area of Interest 

Click the [Save and Exit] button in the upper right corner of the [3D Model Area of Interest 
Settings/Block] page or the [DOM and DSM Area of Interest Settings] page to save the currently 
drawn area of interest and exit the mode. 

 
 

4.3.17 Run Tasks Based On Area of Interest 

After exiting the Area of Interest settings, click the [Start Processing] button on the [Process 
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Settings] page to perform a reconstruction. 
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4.4 Model Blocks 

Model blocks refer to dividing a large 3D model into multiple small blocks for more efficient 
loading, rendering and management. This can improve the rendering efficiency of 3D models 
and reduce loading time, while also improving the performance and scalability of the application. 
In large scenes, use model tiling to better manage and render large numbers of 3D models while 
reducing memory usage and rendering latency. 

 

4.4.1 Using Blocks 

If the Autel Mapper account is not logged in or the account validity period expires, or if the 
newly created project has not run through the aerial triangulation, the [Area of Interest/Block] 
button under the [3D Model] in the [Process Settings] page is grayed out and cannot be 
accessed. 
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When logging in to an Autel Mapper account, and the account is within the validity period, 

click the [Area of Interest /Block] button under the [3D Model] in the [Process Settings] page to 
enter the [3D Mode Area of Interest Settings/Block] page, in this page model block settings can 
be changed. 

 
 

4.4.2 Model Custom Origins 

If you need to merge 3D models of different projects or update local data later, you can turn 
on the [Custom Model Principal Point] switch on the [Process Settings] page to adjust the 
principal point to ensure consistency. 
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Turn on the [Custom Model Principal Point] switch and enter the corresponding point value. 
After clicking the blank space with the mouse, the model principal point can be changed. 

 
Note: 

 If you want to customize the principal point, a pop-up window will prompt to delete the 
dense point cloud and 3D model results. 

 
After selecting the corresponding project output coordinate system, the principal point 

input item will also change accordingly. The ground coordinate system corresponds to X/E, Y/N, 
Z/U, and the projection coordinate system corresponds to longitude, latitude, and altitude. 

Tips: 
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 Changing the project output coordinate system after rebuilding will delete all results. 

 
 

4.4.3 Configure Model Blocks 

In the drop-down menu of [Block Mode] in the [Block Settings] column, you can choose 
three block modes: [Auto], [Custom Memory], and [Custom Length]. 

 
Automatic blocks: 

 The default block mode is [Auto], click the [Block] button to start automatically arranging 
the blocks. 
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Custom blocks: 

 Select [Custom Memory] block, enter [Maximum memory for 1 block], and click the 
[Block] button to start the process. 

 The minimum setting for the maximum allocated memory of a single block is 2GB. 

 
Tips: 

 Check the desired tile in the [Block] list, hover the mouse over the 3D model, you can 
view the number of the corresponding selected tile and highlight the tile. 

 Unselected tiles will display the tile number on hover. 
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Custom Length Blocks: 

 Select the [Custom Length] block and enter the [block length], and click the [Block] 
button to start the block. 

 The block variable length needs to be set at least 100 meters and must be an integer. 

 
When Selecting the [Custom Length] block, you may configure the offset value of each point, 

using X, Y or Z in the [Custom block principal point] column. 

Turn on the [Custom block principal point] switch, enter the offset value, then click the 
[Block] button. 
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4.4.4 Show/Hide Block Layers 

Click the [Show/Hide Block] button in the upper left corner of the [3D Model Area of 
Interest Settings/Block] page to control the display and hiding of the block layer in the view. 

 
 

4.4.5 Save Block Settings 

Click the [Save and Exit] button in the upper right corner of the [3D Model Area of Interest 
Settings/Block] page to save the corresponding block settings. 
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4.4.6 Run Tasks Based On Block Settings 

After exiting the Area of Interest setting mode, click the [Start Processing] button on the 
[Process Settings] page to process the task. 

As shown in the figure below, select two blocks, 1 and 3, for task processing: 

 
You can view the progress under "Processing Details - 3D Model" in the lower right corner 

of the [Process Settings] page. 
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The final processing results are as follows: 

 
 

4.5 View Results And Export 

4.5.1 View Results 

You can open the system directory where the result files are located through the menu bar, 
via [Process->Open Result Folder]. 
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You can also find the directory where the result file is located in the local disk of the 

computer according to the path where the project folder is located. 

In the result folder, you can see the 3dtile, model-osgb, obj, and ply result folders. 

Tips: 

 The tileset.json file in the 3dtile folder is the result format of the 3D model. After 
generating this file, it means that the b3dm format of the 3D model has been processed, 
and the front end renders the result of the 3D model in the program. 
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4.5.2 Export Results 

Click [File->Export 3D Model] in the menu bar to export the results of the 3D model. 
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Click the [Export] icon on the right side of [3D Model] under the layer tree in the [Layers] 

page to export the results of the 3D model. 

 
The export results support the selection of B3DM, OSGB, OBJ, and PLY formats. If the 

corresponding result format is not checked when processing the 3D model, the corresponding 
format cannot be selected when exporting. 
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4.6 3D Reconstruction Quality Report 

After the [3D Model] is processed, the quality report details page will add the processing 
information of the 3D model, including: reconstruction quality, result format, and processing 
time. 

 
 

5. 2D Reconstruction 

5.1 2D Reconstruction Overview 

2D reconstruction is to generate the digital surface model (DSM) and digital orthophoto 
(DOM) of the captured area using images collected by drone. 

 

5.2 2D Reconstruction Process 

5.2.1 Selecting DOM And DSM 

Resolution: 

 Can be divided into N times the ground resolution or the resolution can be set manually. 
The default is the resolution configured by the system. 
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Result Format: 

 GeoTIFF format: Checked by default and must be checked for display in the program after 
generation. 

 
 

5.2.2 DOM And DSM Processing Steps 

DOM and DSM need to rely on the results of aerial triangulation. You can perform aerial 
triangulation first, and then process DOM and DSM separately; you can also choose aerial 
triangulation, DOM and DSM to process together. 

DOM and DSM can be processed simultaneously with the 3D model or separately. 

After checking [DOM and DSM] on the [Process Settings] page, and setting the resolution, 
click the [Start Processing] button to process. 

Tips: 

 [DOM and DSM] column is not checked by default, it needs to be checked manually. 

During processing, you can click the [Stop] button to stop processing. 
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The results of DOM and DSM can be viewed in the layer tree and 2D view of the [Layers] 

page. 

Tips: 

 When DOM and DSM are selected at the same time, only DSM is displayed in the view. 
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5.3 View Results And Export 

5.3.1 View Results 

Click [Process->Open Result Folder] on the menu bar to open the system directory where 
the results file is located. 

You can also find the directory where the result file is located in the local disk of the 
computer according to the path where the project folder is located. 

You can see the dom.tif and dsm.tif result files in the result folder. After the file is generated, 
it means that the 2D reconstruction has been processed, and the front end renders the DOM 
result in the program. 
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5.3.2 Export Results 

Click [File->Export DOM] and [File->Export DSM] in the menu bar to export the results of 
DOM and DSM, and the format of the results is tiff format. 
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Right-click [DSM] or [DOM] under the layer tree in the [Layers] page or click the [Export] 

icon on the right to export DSM or DOM results. 

 
 

5.4 2D Reconstruction Quality Report 

After processing [DOM and DSM], the quality report details page will add DOM and DSM 
processing information, including: DSM result format, DOM result format, processing time, DSM 
preview, DOM preview. 
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 Task Queue Management 
 

This chapter mainly describes the reconstruction task queue management within Autel 
Mapper. 
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1. Introduction To Task Queues 

Autel Mapper supports the creation of multiple quality reconstruction tasks (can be a 
combination of [Aerial Triangulation], [Aerial Triangulation] and [Dense Point Cloud], [3D 
Model], [DOM and DSM], etc. After completion, the task combination of [Dense Point Cloud], 
[3D Model], [DOM and DSM], etc.) is put into a task queue for queuing processing, and the tasks 
put into the task queue can be prioritized, canceled or suspended. 

 

2. Task Queue Management 

2.1 Add Task 

After checking the tasks that need to be rebuilt on the [Process Settings] page, click the 
[Start Processing] button, and the tasks will be automatically added to the task queue. You can 
click the [Queue] icon in the upper right corner to view the task queue. 

 
 

2.2 Task Prioritization 

Click the [Priority] button in the corresponding item operation column on the [Queue] page 
to set the item to the top. 
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You can also click and hold the drag icon on the right side of the [Priority] button of the 

corresponding item operation column on the [Queue] page to perform upward or downward 
sorting management. 

 
 

2.3 Suspend Task 

Click the [Pause queueing] button in the upper right corner of the [Queue] page to pause 
the operation. 
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Click the [Continue queueing] button in the upper right corner of the [Queue] page to 

resume the operation. 

 
After clicking the [Pause queuing] button in the upper right corner of the [Queue] page to 

pause the operation, the newly created reconstruction task can be added to the bottom of the 
task queue for queuing. At this time, you can click [Continue] button in the [Process Settings] 
page to resume task queue processing. 
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You can also go back to the [Queue] page and click the [Continue Queuing] button in the 

upper right corner to resume task queue processing. 

 

2.4 Cancel Task In Queue 

 Click the [Cancel] button in the corresponding column on the [Queue] page to delete the 
project task from the task queue. 

 You can check the square brackets before the sequence number of the corresponding 
project on the [Queue] page, and then click the [Remove from Queue] button on the 
upper left to delete the project task from the task queue. 

 You can check the square brackets in front of the sorting column on the [Queue] page to 
select all project tasks, and then click the [Remove from Queue] button on the upper left 
to delete all project tasks from the task queue. 
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2.5 Task Queue Result Record 

The task queue results record can view completed and canceled tasks, and supports task 
searching. Re-opening after the software is closed will clear the records before the software was 
closed previously. 

You can view the corresponding records in the result record for tasks added to the task 
queue, canceled or completed. 

Click the [Clear Records] button on the [Records] page to clear the project processing record. 

 
You can search for specified project task records in the search bar on the [Records] page, 
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which supports exact match search and relative search. 
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 Log Uploading 
 

This chapter describes uploading logs through Autel Mapper. 
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1. Introducing Log Uploads 

Uploading logs can help developers and technical support personnel better understand the 
reasons for client failures, so that they can solve problems faster, and help Autel intelligently 
improve the stability of Autel Mapper. 

 

2. Upload Log 

2.1 Uploading Log When Task Fails 

When a project processing fails, a floating window of the log will pop up, and the user can 
choose whether to upload the data or not. 

 
You can view the upload progress in the upper right corner of the page, note that the client 

cannot be closed during the upload process. 
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2.2 Upload Specific Log From Project  

In the project list on the homepage, click the […] icon in the project and select [Upload Log] 
in the pop-up menu to upload the project log. 

 
Click [File->Upload Log] in the completed project to upload the log of the project. 
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